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Software License Agreement: Terms and Conditions 

The media accompanying this book contains software ("the Soft
ware") to be used in connection with the book. SYBEX hereby 
grants to you a license to use the Software, subject to the terms 
that follow. Your purchase, acceptance, or use of the Software will 
constitute your acceptance of such terms. 
The Software compilation is the property of SYBEX unless other
wise indicated and is protected by copyright to SYBEX or other 
copyright owner(s) as indicated in the media files (the "Owner(s)"). 
You are hereby granted a single-user license to use the Software for 
your personal, noncommercial use only. You may not reproduce, 
sell, distribute, pub1ish, circulate, or commercially exploit the Soft
ware, or any portion thereof, without the written consent of SYBEX 
and the specific copyright owner(s) of any component software 
Included on this media. 

Software Support 

Components of the supplemental software and any offers associ
ated with them may be supported by the specific Owner(s) of 
that material but they are not supported by SYBEX. Information 
regarding any available support may be obtained from the 
Owner(s) using the information provided in the appropriate 
read .me files or listed elsewhere on the media. 
Should the manufacturer(s) or other Owner(s) cease to offer sup
port or decline to honor any offer, SYDEX bears no responsibility. 
This notice concerning support for the Software Is provided for 
your Information only. SYBEX is not the agent or principal of the 
Owner(s), and SYBEX is in no way responsible for providing any 
support for the Software, nor is it liable or responsible for any sup
port provided, or not provided, by the Owner(s). 

Warranty 

SYBEX warrants the enclosed media to be free of physical defects 
for a period of ninety (90) days after purchase. The Software is 
not available from SYBEX in any other form or media than that 
enclosed herein. If you discover a defect in the media during this 
warranty period, you may obtain a replacement of Identical for
mat at no charge by sending the defective media, postage pre
paid, with proof of purchase to: 

SYBEX Inc. 
Customer Service Department 
1151 Marina Village Parkway 
Alameda, CA 94501 
(510) 523-8233 
Fax: (510) 523-2373 
e-mail: info@sybex.com 

After the 90-day period, you can obtain replacement media of 
identical format by sending us the defective disk, proof of pur
chase, and a check or money order for $10, payable to SYBEX. 

Disclaimer 

SYBEX makes no warranty or representation, either expressed or 
implied, with respect to this media or its contents, its quality, 
performance, merchantability, or fitness for a particular purpose. 
In no event will SYBEX, its distributors, or dealers be liable to 
you or any other party for direct, jndirect, special, Incidental, 
consequential , or other damages arising out of the use of or 
inability to use the media or its contents even if advised of the 
possibility of such damage. 
The exclusion of implied warranties is not permitted by some 
states. Therefore, the above exclusion may not apply to you. 
This warranty provides you with specific legal rights; there may 
be other rights that you may have that vary from state to state. 
The pricing of the book with the Software by SYBEX reflects the 
allocation of risk and limitations on liability contained In this 
agreement of Terms and Conditions. 

Shareware Distribution 

This Software media may contain various programs that are dis
tributed as shareware. Copyright laws apply to both shareware 
and ordinary commercial software, and the copyright Owner(s) 
retains all rights. if you try a shareware program and continue 
using it, you are expected to register it. Individual programs dif
fer on details of trial periods, registration, and payment. Please 
observe the requirements stated in appropriate flies. 

Copy Protection 

None of the files on the disk is copy-protected. However, in all 
cases, reselling or redistributing these files without authorization 
is expressly forbidden except as specifically provided for by the 
Owner(s) therein. 
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INTRODUCTION 

elcome to Mastering Access 97, the 
book for new and intermediate 
Microsoft Access users and for aspir

ing application developers. Like Access, this book is geared toward experienced Windows 
users. You don't need to be a Windows genius to use Access, but if you're just making 
the transition from DOS to Windows, or just getting started with computers, you'll 
surely want to get your Windows "basic skills" down pat before you start using Access. 
(Our book, Alan Simpson's Easy Guide to Windows 95, can help you do that. It's also pub
lished by Sybex.) 

Just in case you're wondering, we used Windows 95 exclusively while writing this 
book; however, Access 97 also runs under Windows NT, and we've sprinkled a few 
notes about Windows NT throughout the text. Readers who are using Windows NT 
should have little trouble following our instructions, although you may encounter 
some minor differences along the way. 

New to Database Management? 
You don't need to know anything about database management or programming to use 
this book. We start at square one in Chapter 1. As for programming-don't worry 
about it. Programming is definitely in the "not required" category when it comes to 
using Microsoft Access. 

New to Recess 97 but an Old Hand at Recess? 
If you're an old hand at using Microsoft Access but are trying (or planning to try) 
Access 97 for the first time, you can find out what's new by flipping to the "What's 
New in the Access Zoo?" sidebars at the end of each chapter. These brief sections high
light important new features that relate to the chapter you've selected. 

If you have old Access databases that you'd like to use with Access 97, be sure to 
check Appendix A of this book for an introduction to points you must consider before 
removing your old version of Access and for information about converting your exist
ing databases. 
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Finally, you can view online details of what's new. After installing Access, simply 
open the What's New book in the Access 97 Help Contents (or search for What's New 

with the Office Assistant) and then explore the many subtopics that appear. Chapter 1 
explains how to use the Access online help. 

A Focus on Creating Applications 
Microsoft Access is a huge product, and nearly every nook and cranny of it is already 
documented in the online help. In this book, rather than wasting paper repeating all 
of that information, we've opted to focus on two things: (1) general day-to-day use of 
Microsoft Access and (2) using Access to create custom Windows applications. To meet 
those goals, we've organized the book as follows: 

Part I An Overview of Access This part is for experienced Windows users who 
are new to database management and/or Access. Here we cover basic skills and 
concepts and offer a hands-on guided tour. 
Part II Creating a Database This second part of the book covers all the basic 
Access objects you'll create to manage your data-tables, queries, forms, reports
and to publish your data to the Web. The information presented here is vital to 
casual users, to more ambitious application developers, and to aspiring developers. 
Part III Database Tuning and Administration Here you'll learn how to per
sonalize Access, speed up databases for optimal performance, administer your 
databases and use database replication, and take advantage of networking and 
security features. 
Part IV Building a Custom Application Most Access users eventually realize 
that, with just a little more effort, they can turn their databases into easy-to-use 
stand-alone Windows applications. Part IV of this book is all about that topic
creating applications. 
Part V Refining a Custom Application We wrote the final part of this book for 
application developers who aspire to learn Visual Basic programming and other 
more advanced application topics. 

This book offers several features that will help you learn Access and find the infor
mation you need, when you need it. Here are some examples: 

• Notes, Tips, and Warnings. These provide good ideas, shortcuts, references to 
related topics, and cautions that point out when you might want to think twice 
before clicking that mouse! 
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• Sidebars. Sprinkled throughout the book, sidebars provide useful tidbits that will 
help you work smarter with Microsoft Access or Windows 95. 

• What's New in the Access Zoo? Designed to help people upgrading to Access 97, 
these end-of-chapter sections highlight new features discussed in the chapter. 

• Access in an Evening. Chapter 3 is a hands-on guided tour of Access, designed to 
give you a feel for working with the program in just a few short lessons. 

• About Access, Office, Windows 95, and the Internet. Chapter 4 highlights com
mon features in Access, Office, and Windows 95 so you can learn Access more 
quickly and take advantage of integration between Access and other programs in 
Microsoft Office. Learn to use the new Hyperlink feature to link Access databases 
to the Web! 

• CD-ROM. The CD-ROM in the back of this book contains a great multimedia cat
alog of ready-to-run Access applications that you can purchase separately, as well 
as demos, shareware, freeware, sample databases, and more. See Appendix B for 
more information. 

, . . · . 

We use the standard terminology that just about everyone else uses to discuss Access. 
However, we do use a shortcut method to display a series of commands and/or options 
you follow to get a particular job done. We present the commands in the order you'll 
select them, separated with a ~ symbol. 

For example, the instruction Choose Help ~ About Microsoft Access means 
"Choose About Microsoft Access from the Help menu" (using either the keyboard or the 
mouse) . And the instruction Choose Start~ Programs ~ Microsoft Access means 
"Click on the Start button on the Windows 95 Taskbar, choose the Programs option 
from the Start menu, and then choose the Microsoft Access option from the menu that 
appears" (again, using either the keyboard or the mouse). This approach lets you see, 
at a glance, the exact sequence of commands you must choose to get a job done. It 
also helps you remember command sequences that you use often. 

We also use toolbar buttons and other symbols in the margin. The toolbars provide 
a convenient way to perform many common Access operations with a simple mouse 
click. For example, clicking on the Print button shown at left prints the currently 
highlighted table, query, form, macro, or module. You'll often see a button in the mar
gin the first time it's called for within a chapter. 
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Our sincerest thanks go to you for choosing this book. We hope it serves you well. As 
usual, we welcome comments, criticism, and suggestions. You can reach us at: 

Alan Simpson 
Elizabeth Olson 
c/o Sybex, Inc. 
1151 Marina Village Parkway 
Alameda, CA 94501 
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Getting Started 
and Getting Rround 

icrosoft Access 97 for Windows 95 is a 
database management system, or 
DBMS. As the name implies, a DBMS 

helps you to manage data that's stored in a computer database. The data you manage 
can be virtually anything, including 

• Names and addresses 
• Business contacts, customers, and sales prospects 
• Employee and personnel information 
• Inventory 
• Invoices, payments, and bookkeeping 
• Libraries and collections 
• Schedules, reservations, and projects 

You may already know what kinds of data you plan to manage with Access 97, and 
you may already be familiar with other database programs and with the basic concepts 
of database management. If not, you'lllearn more about databases in the next chapter. 
But whether you're a seasoned veteran eager to start working in Access or a database 
newcomer wondering where to begin, the first step is to learn how to start Access and 
use its extensive Help system to coach you along as you work. 
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I 

Access Isn't Just for Techies! 

Don't worry if you know nothing about 
databases and don't want to become an 
expert on the topic. Access Wizards can 
guide you through almost any step, and 
they can create databases for you auto
matically. So even if you need to set up 
something as complex as a system for 
managing orders, inventory, or assets- or 
something as simple as keeping a list of 
contacts and bi1thdays-Access Wizards 
can take care of the grunt work while you 
focus on getting useful information from 

To start Microsoft Access 97: 

1. Start Windows 95 in the usual manner. 

your computer. You'll have a chance to 
try Wizards during the hands-on tour in 
Chapter 3 and in many other chapters of 
this book. 

If you're a technical type, never fear! 
Access has more than enough to make 
you happy. It's a full-featured application 
development system that includes the 
Visual Basic programming language and 
other tools for setting up sophisticated 
applications for yourself and your custom
ers. You'll learn more about these features 
in Parts Four and Five. 

If you're using Microsoft Office for Windows 95 and have added Access 97 to the 
Microsoft Office Shortcut Bar, you can start Access by clicking on the appropriate 
button on the Office Shortcut Bar (see Chapter 4) . Or if you've set up a shortcut 
icon for Access on the Windows desktop, you can double-click on that icon to start 
Access. Then skip to step 3 below. 

-------------------------------------------------------------:~ 
2. Click on the Start butto n on the Windows 'J'askbar and then choose Programs > 

Microsoft Access. 

After a short delay, yo u' ll sec the Mi crosoft Access 97 startup dialog box shown in 
Figure 1. I. (If yo u've just installed Access 97, the list box below the Open An 
Ex isting Database option is empty.) 

3 . l)o an y of the followi ng: 

• To create a new bta'nk database, choose Blank Database and then click on OK. 



anew••• 
The Microsoft 

Access 97 
startup dialog 

box. From here 
you can create a 

new database, 
open an exist

Ing one, or click 
on Cancel to go 

to the main 
Access window. 
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Click on one of these options and 
then click on OK to create a new database. 

Mrcroooft Ar.<:a.. fiE) 

r Qat..base Wizard 

Click on this option to open an existing 
database. Then click on a recently 
used database name or click on More Files 
to search for and open a database. 
Finally, click on OK. 

Click on Cancel to go directly to the 
main Microsoft Access 97 window. 

• 

To use the Database Wizard to create a new database, choose Database Wiz
ard and then click on OK to open the New dialog box. (More about creating 
new databases in Chapter 5.) 

• To open an existing database, choose Open an Existing Database. If a list of 
database names appears, click on a recently used database name in the list or 
click on More Files so you can look for the database you want to use. Click on 
OK. See "Opening an Existing Database" later in this chapter for more details. 

• To go to the main Microsoft Access 97 window (shown in Figure 1.2) with
out creating or opening a database, click on the Cancel button or press Esc. 

c>..-IE 

If Access is customized to bypass the startup dialog box, you'll be taken to the 
main Access window as soon as you finish step 2 above. We explain how to 
bypass the startup dialog box later in this chapter. 

0 

j 
c 
< 
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Organizing the Start ~ 
Programs Menu Items 
If your Start ,.. Programs menu has too 
many entries or isn't organized the way you 
like, you can rearrange it easily. Suppose 
you want to move Microsoft Access 97 
and other Microsoft Office programs from 
the main Start,.. Programs menu into 
a Microsoft Office submenu that looks 
something like the image below. 

All it takes is a little knowledge of Win
dows Explorer and these basic steps: 

1. Right-click on the Start button on the 
Taskbar and choose Explore. 

2. Click on the Programs folder in the 
left pane of the Exploring window (it's 
below the Start Menu folder). The 
right pane will show the contents of 
the Programs folder. 

3. Right-click your mouse on an empty 
part of the right pane of the Exploring 

New 0 If ice Document 
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window and choose New ,.. Folder 
from the shortcut menu. 

4. Type a new folder name, such as 
Microsoft Office, and press Enter. 

5. Click on the+ sign next to the Programs 
folder in the left pane; then use the 
vertical scroll bar to scroll the left pane 
until you can see the new folder you 
created in step 4. 

6. Drag the program (or folder) you 
want to move from the right pane to 
your new folder in the left pane. 

7. Repeat step 6 as needed and then 
click on the Close button in the 
Exploring window. 

For more details on customizing the Start 
menus, choose Start,.. Help and click on 
the Index tab. Then type Start Menu, 
Reorganizing and press Enter. To learn 
more about Windows Explorer, look up 
topics below Windows Explorer on the 
Index tab in Help. 

~~~~~-ill···· ~ MicrowftAccE-ss 
• ~ Microsoft Binder 

~ ~ Microsoft Excel 

• .:t) Novell PerlectOIIice ~ !iJ Microsoft Exchange 

-----=~: 

Sh]Jt Down 

.'t) StartUp ~ t:J Micro,olt Office File New 

.:frl WinFax • 0 Microsoft Ollrce File Open 

uE} Wir~rp • 0 Microsoft Office Shortcut Bar 

B MS·DOS P10mpt :l,:i Microsoft Oullook 

~ Microsoft Powe1Point 

lW Microsoft Word 

-0 
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IV 
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Creating a Desktop Shortcut 

You can use a shortcut icon to launch a 
program or open a file by double-clicking 
on that icon on the Windows desktop. To 
quickly add an icon that will launch the 
Access program from the desktop, mini

mize or close any open windows and then 
follow these steps: 

1. Use Windows Explorer to open 

the folder that contains Microsoft 
Access 97. For example, right-click on 
the Start button on the Windows 
Taskbar, choose Explore, double-click 

on the MSOffice folder (it's usually on 
drive C), and then double-click on the 
Access folder. 

To open a database: 

2. Locate the Msaccess program icon, 
which has a picture of a key next to 
the Msaccess program name. 

3. Hold down the right mouse button 
while you drag the icon to the Win
dows desktop. Release the mouse 
button. 

4. Choose Create Shortcut(s) Here from 

the shortcut menu. 

In the future, you can start Access by 
double-clicking on the Shortcut to 

Msaccess icon on your desktop. To discover 
other ways to create shortcuts for Access, 
look up the Shortcuts topics in the Access 
Help index or the Windows Help index. (To 
get Windows Help, click on the Start button 
on the Taskbar and choose Help.) 

1. l)o one of the following, depending on whether you're starting from the startup dia
log box, from the main Microsoft Access window, or from the Windows desktop: 
• I;rom the startup dialog box (refer to Pigure 1.1 ), choose Open an Existing 

Database (this is the default choice). Then if the database nam e you want to 
open is shown in the list, double-click on that narrie and you're done. If the 

database name isn't in the list, double-click on More Files and continue with 
step 2. (lf no list appears, click on OK and continue with step 2.) 

~v---• ~ 1 As usual in Windows, you can choose an option in a list by clicking on it and then 
clicking on 01< (or whatever button carries out the default command), or by click
ing on the option and pressing Enter. Or for quicker selection, try double-clicking 
on the option you want. 
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• From the main Microsoft Access window (refer to Figure 1.2), choose File> 
Open Database or click on the Open Database toolbar button (shown at left) or 
press Ctrl+O. You'll see an Open dialog box, similar to the example shown in 
Figure 1.3. 

-r•P 

WitdM••• 
The Open 

dialog box. 

If you've recently used the database you want to open, try this tip for opening the 
database quickly: Choose File from the menu bar, look for the database name near 
the bottom of the File menu (just above the Exit option), and then click on its name 
or type the number shown next to its name. 

Type a path name and press Enter, 
or choose a name from the drop-down list. 

Double-click on an item 
in the list to open it. 

Open the highlighted 
database name. 

Ill 
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0 rder E ntry1 

• From the Windows desktop, locate the database using standard techniques in 
Windows Explorer, My Computer, or Network Neighborhood. When you find 
the database you want to use, double-click on its name or icon (see the sample 
icon, shown at left). Or if you've used the database recently, click on the Start 
button on the Windows Taskbar, choose Documents, and then click on the 
name of your database in the list that appears. Access will start and the data
base will open. You're done, so you can skip steps 2 through 5. 

2. Use any of these methods to find the database you want to open: 

• To open an object shown in the list below Look in, double-click on the appro
priate object icon or name. 

• To choose the computer, drive, or folder where the database is stored, click 
on the Look in drop-down list button and then click on the appropriate item. 

• To open the folder that's just above the currently selected folder, click on 
the Up One Level button in the Open dialog box, or click anywhere in the list 
below Look in and then press Backspace. 

To learn the purpose of any toolbar button in a window or dialog box, move your 
mouse pointer to that button and look for the Screen Tip near the mouse pointer. 
See "Using the Toolbars" later in this chapter for more information. 

• To display a list of your Favorite databases and folders, click on the Look In 
Favorites toolbar button. The list below Look in will then show your favorite 
folders and databases only. 

• To add an item to your Favorites list, make sure the appropriate item appears 
in the Look in text box or click on an item name in the list below Look in. 
Then click on the Add to Favorites toolbar button and choose an option from 
the menu that appears. 

• To manually enter a drive, directory, and/or file name, type the appropriate 
information into the File name text box in the lower part of the Open dialog 
box or choose an item from the File name drop-down list. 

• To change the appearance of the list below Look in, click on the List, Details, 
Properties, or Preview toolbar button. 

You can delete, rename, and do other handy operations on items from the Open 
dialog box. To begin, click on an item in the list below Look in. Then right-click on 
the item and choose an option from the shortcut menu. 



OPENING AN EXISTING DATABASE 

3. If you're choosing the database from the list below Look in, make sure the database 
name is highlighted in the list (click on it if necessary). 

4. If you're on a network and you need to open the database for your exclusive use, select 
(check) the Exclusive box on the right side of the dialog box. Select the Exclusive 
option only if you're sure you need to prevent other people from updating informa
tion in the database (they'll still be able to view the data). Otherwise, leave the 
checkbox empty so that other people can view and update the database as needed. 

Don't worry. Access automatically makes sure that no two people can update 
information simultaneously and get the data out of sync. See Chapter 18 for 
more information about networking and security. 

5. Click on the Open button. (As a shortcut for steps 3 and 4, you can double-click on 
a database name in the list below Look in.) 

The database will open, and you'll see either the database window or a form that 
either describes the database or lets you work with it. 

If the database you're planning to open usually displays a form, but you'd prefer to 
bypass that form and go directly to the database window, hold down the Shift key 
while you open the database. This action bypasses the form and any options that 
are set in the Startup dialog box (Tools>- Startup). 

As Figure 1.3 shows, the Open dialog box contains many buttons and special fea
tures that we haven't mentioned here. If you've played with other Open dialog boxes 
in Microsoft Office or you've spent some time with Windows Explorer, you'll learn the 
fine points quickly. For more guidance, click on the? button in the upper-right corner 
of the Open dialog box and then click on the part of the dialog box you're curious 
about. Feel free to experiment! 

Opening the Sample Northwind Database 
Let's suppose you did a normal Access setup and installed the sample databases. Here's 
one way to open the Northwind sample database that comes with Access: 

1. Choose Open An Existing Database from the Microsoft Access startup dialog box. 
Then highlight More Files (if it's available) and click on OK. 

Or 

Choose File )>- Open Database from the main Microsoft Access window. 
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2. Double-click to open the MSOffice folder (usually on drive C:), the Access folder 

below MSOffice, and then the Samples folder below Access. 

3. Double-click on Northwind in the list below Look in. 

4. Click on 01< to go to the database window if the Welcome form appears . 

You'll find a shortcut to the sample Northwind database (appropriately named 
Shortcut To Northwind) in the My Documents folder that usually appears when you 
choose File ~ Open Database. You can double-click on that shortcut to open 
Northwind if you prefer. 

Maximizing Your On-Screen 
Real Estate 

The Windows 95 Taskbar can take up valu

able on-screen real estate that you might 

prefer to make available to your database 

objects. Fortunate ly, hiding the Taskbar 

temporarily and bringing it into view only 

wher1 you need to is easy. (Most screen 

shots ir1 this book were taken with the Task

bar hidden .) 

To hide the Taskbar temporarily, right

click on any empty spot on the Taskbar, 

choose Prope rties, make sure the Always 

On Top and Auto Hide options in the 

Toskbar Properties dialog box are checked, 

and then click on OK. In the future, the 

Taskbar will remain hidden until you 

move your mouse pointer to the edge 

of the screen where the Taskbar was lurk

ing the last time you used it. (If you don't 

remember where the Taskbar was, move 

the mouse pointer to the bottom, top, 

left, or right edge of the screen until it 

pops into view.) 

To display the Taskbar permanently again, 

return to the Taskbar Properties dialog box 

and deselect (clear) the Auto Hide option. 

(It's usually best to leave Always On Top 

checked.) Then click on OK. 

The various p/1j,·cts (a term for d;rtabcrse componen ts such as tables and forms) will 

appear in the dclla/Josc window (see Figure 1.4). You can move, size, maximize, mini

mize, aml res tore the database window using a ll the sta ndard Windows techniques. 
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The Northwind 

database 
window with 

the Tables 
tab selected. 
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• 
1. Click on the tab for the type of object you want to work with . Tool bar 

Iii Queries I ~ Forms I 8 Reports I z:% Macros I 

lllil Customers 

lllil Employees 

lllil Order Details 

lllil Orders 

lllil Products 

lllil Shippers 

lllil Suppliers 

2. To open or change an object, click on its name. Database window 

What Is a Database, Anyway? 
A widely accepted definition of a database is "a collection of data related to a particular 
topic or purpose." If that sounds a bit stuffy, just think of a database as a general-purpose 
container for storing and managing information. The information can be anything from 
names and addresses to details about your business's inventory and orders. 

There's more to a database than data. A database can also contain objects to help you 
manage that data, such as forms (for entering and editing data) and reports (for print
ing data in the format you want). All told, a database can contain any combination of 
these six types of objects: 

Table Tables are the fundamental structures in an Access database because they 
store the data you'll be managing (see Chapter 6) . Within a table, data is organized 
into fields (columns) and records (rows) . 
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Query A query is a tool for asking questions about data in your tables and for per
forming actions on data (see Chapter 10). Queries can answer questions, such as: 
How many customers live in Connecticut and what are their names and phone num
bers·! You can use queries to combine or joi11 data from many separate but related 
tables. A query can, for example, join Customers, Orders, Order Details, and Products 
tables to answer the questions: Who ordered left-handed farkledorfers? and What is 
the value of those orders? Queries also can help you change, delete, or add large 
amounts of data in one fell swoop. Finally, you can use queries as the basis for your 
forms and reports. 
Form Forms let you display and enter data in a convenient format that resem
bles fill-in-the-blank forms (see Chapters 11 and 13). Your forms can be plain and 
simple or quite elaborate with graphics, lines, and automatic lookup features that 
make data entry quick and easy. Forms can even include other forms (called sub

forms) that let you enter data into several tables at once. 
Report Reports let you print or preview data in a useful format (see Chapters 12 
and 13). Like forms, reports can be plain or fancy. Examples include mailing 
labels, lists, envelopes, form letters, and invoices. Reports also can present query 
results in an easy-to-understand format. For instance, you can print sales by cus
tomer, receivables aging, and other management information for use in making 
business decisions. 
Macro A macro is a set of instructions that automates a task you need to do often 
(see Chapter 20). When you run a macro, Access carries out the actions in the macro 
in the order in which the actions are listed. Without writing a single line of program 
code, you can define macros to automatically open database forms, print mailing 
labels, process orders, and more. Macros enable you to assemble a collection of tables, 
queries, forms, and reports into turnkey applications that anyone can use, even if they 
know little or nothing about Access itsel f. 
Module Like macros, modules allow you to automate and customize Access (see 
Part Five). However, unlike macros, modules give you more precise control over the 
actions taken, and they require you to have Visual Basic programming expertise. 
You may never need to use modules, so don't worry if you're not a programmer. 

During the hands-on lessons in Chapter 3, you'll have a chance to create a database 
complete with tables, forms, reports, queries, and even a simple form module. You'll be 
astounded at how quickly you can do this job when you let the Wizards do all the 
tough stuff for you. 
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Working in the Database Window 
The database window is one of your main tools for using Access. When exploring the 
sample North wind database and when creating databases of your own, you'll use this 
simple three-step process to work with the objects in your database: 

1. Choose the type of object you want to create, use, or change using the tabs near the 
top of the database window. That is, click on the Tables, Queries, Forms, Reports, 
Macros, or Modules tab. 

2. Click on its name in the list of objects if you want to use or change an existing object. 
3. Do one of the following: 

• To create a new object of the type you selected in step 1, click on the New 
button near the side of the database window. 

• To use (or view or run) the object, click on the Open (or Preview or Run) button. 
• To change the object's appearance or structure, click on the Design button . 

......... 
As a shortcut for opening (or previewing or running) an object, you can double
click on its name in the database window. 

What happens next depends on the type of object you selected and on the type of 
operation you chose in step 3. We'll say more about the various types of objects in 
upcoming chapters. 

Closing an Object 
Regardless of how you open an object, you can use any standard Windows technique 
to close it. Here are three sure-fire methods: 

• Click on the Close (x) button in the upper-right corner of the window you want to 
close (not the Close button for the larger Microsoft Access program window) . 

• Choose File >- Close from the Access menu bar. 
• Press Ctrl+W or Ctrl+F4. 

Some Access windows also display a Close button on the toolbar. 
If you've changed the object you were viewing, you may be asked if you want to save 

those changes. Respond to the prompt accordingly. 
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Uncovering a Hidden Database Window 
Sometimes the database window will be invisible even though you've opened a data
base. If that happens, you can return to the database window (assuming the database is 
open) by using any of these techniques: 

• Press the Fll key. 

• 

• Choose Window > ... : Database from the menu bar (where ... is replaced by the 
name of the open database, such as Northwind). 

• Click on the toolbar's Database Window button (shown at left) . 

If none of those methods works, close any other objects that are on the screen and 
try again. If you still can't get to the database window, you've probably closed the data
base. To reopen the database, choose File from the Access menu bar and then click on 
the name of the database near the bottom of the menu. Or use File > Open Database 
as discussed earlier in this chapter. 

~-~..--=: 

When you open some databases, a custom form window, rather than the data
...___0111 base window, will appear. That's because whoever created that database has 

turned it into an application. Even so, pressing F11 usually will take you to the 
database window (unless the application designer has disabled this feature). 
Often you can bypass the initial form window and all the other startup options by 
holding down the Shift key as you open the database. 

Changing Your View of Database Objects 
You can use options on the View menu, or equivalent buttons on the toolbar, to 
change the size of objects and amount of detail listed for objects in the database win
dow. Table 1.1 summarizes these options and buttons. In Figure 1.4, for example, we 
clicked on the List button on the tool bar (alternatively, View> List) to display database 
objects in a list. 

Managing Database Objects 
The database window lets you do much more than just open objects. You also can use 
that window to manage the objects in a database-that is, to copy them, delete them, 
rename them, and so on. Here's how: 

1. If the object you want to work with is currently open, close it, as described earlier 
under "Closing an Object." 
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MANAGING DATABASE OBJECTS 

TABLE 1.1: VIEW MENU OPTIONS AND EQUIVALENT TOOLBAR BUTTONS 

VIEW 
MENU 

OPTION 

Large Icons 

Small Icons 

List 

Details 

BUTTON 

' .!L I 
·2.1 

DESCRIPTION 

Shows each object as a large icon with the object 
name below the icon. Object names initially appear in 
rows; however, you can drag them as needed. 

Shows each object as a small icon with the object name 
next to the icon. Object names initially appear in hori
zontal rows; however, you can drag them as needed. 

Shows each object as a small icon with the object 
name next to th.e icon. Object names appear vertically, 
in one or more columns. 

Shows each object as a small icon with the object 
name next to the icon. Object names appear with one 
object to a line and five columns of detail about each 
object. The columns list the object's Name, Descrip
tion, date/time Modified, date/time Created, and 
object Type. 

• To resize a column, move your mouse pointer to the 
vertical divider that's just to the right of the column 
heading. When the pointer changes to a crosshair, 
drag the mouse to the left or right; or double-click on 
the divider for a snug fit. 

• To sort by a column (in ascending order), click on the 
appropriate column header button. To sort the column 
in descending order, click on the column header 
button again. 

• To add a Description to any object, right-click on the 
object name in the database window, choose Proper
ties, type a Description, and then click on OK. 

Note: You can use the View >- Arrange Icons and View >- Line Up Icons commands on the menu bar 

(or right-click on a blank area on the database window and choose View, Arrange Icons, or Line Up 
Icons options from the shortcut menus) to rearrange and line up icons as needed. 
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2. If you haven 't already done so, choose the type of object you want to work with (by 
clicking on tbe Tables, Queries, Forms, Reports, Macros, or Modules tab on the data
base window) . 

3. Click on the name of an object and then: 

• To delete the object, choose Edit )o.. Delete or press Delete; click on Yes when 
prompted for confirmation. To delete the object and move it to the Windows 
Clipboard (without being asked for confirmation), hold down the Shift key 
while pressing Delete or press Ctrl+X (be careful, there's no undo (or this operation; 
however, you can paste the object from the Clipboard by pressing Ctri+V). 

• To rename the object, click on the object name again (or choose Edit )o.. 

Rename), type a new name (up to 64 characters, including blank spaces if you 
wish), and then press Enter. 

• To copy the object into this same database, choose Edit )o.. Copy or press 
Ctrl+G. Then choose Edit )o.. Paste or press Ctrl+V. Enter a valid object name (up 
to 64 characters), choose other options as appropriate, and then click on OK. 
The copy will appear in the list of objects in its proper alphabetical position. 
(You may need to scroll through the object names to find the copy.) Copying 
can give you a head start on designing a table, form, report, or other object 
that should be similar to the object you copied. You can then change the cop
ied object without affecting the original. 

• To create a shortcut icon on the Windows desktop for the selected object, 
choose Edit )o.. Create Shortcut, specify the Location (if you wish), and then click 
on OK. In the future, you can double-click on the shortcut icon on the Windows 
desktop to start Access and open the object in one fell swoop. 

Another way to create a shortcut to an Access object is to size the Access window 
so that you can see Access and the Windows desktop at the same time (one way is 
to right-click on an empty place on the Windows Taskbar and choose Cascade). 
Then, if you want to put the shortcut in a folder, open that folder in Windows 
Explorer, My Computer, or Network Neighborhood. Finally, drag and drop the 
selected Access object to the desktop or folder. You also can drag and drop tables 
and queries from the database window to Microsoft Excel, Microsoft Word, and 
other program windows (see Chapter 4). 

• To print the object, choose File )o.. Print or press Ctrl+P or click on the Print tool
bar button (shown at left). Then click on OK from the Print dialog box to print 
the entire object. 
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• To preview the object before printing, choose File ~ Print Preview or click 
on the Print Preview toolbar button (shown at left). When you're done preview
ing the object, close it as described earlier under "Closing an Object." 

• To export the object to another Windows program or to a different Microsoft 
Access database, choose File >- Save As/Export. Complete the dialog box and click 
on OK. 

• To export the object to HTML or another Web format, choose File ~ Save to 
HTML/Web Formats. 

• To import or link data from another program or database, choose File >
Get External Data and then choose either Import or Link Tables. Complete the 
dialog box that appears and then click on the Import or Link button. 

Many of the operations described above also are available when you right-click on 
an object or right-click on any gray area on the database window. See "Opening 
Shortcut Menus" later in this chapter for details. 

See Chapter 7 for more information about moving and copying objects between 
databases or about interacting with other programs. Or search the Access Help index for 
any of these topics: Exporting Data ... , Importing Data ... , and Linking .... 

Using the Toolbars and Menu Bar 
Toolbars offer time-saving shortcuts to commonly used commands. To use the 
tool bars: 

1. Move the mouse pointer to the toolbar button you want to choose. 
2. Look at the status bar for a description of the current button. Or wait a moment, 

and a brief description (called a ScreenTip) will appear near the mouse pointer, as 
shown below. 

fie [dit 'iiew jnserl 

Dl~l 
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W#dU;liiW 
Examples of 

square (normal) 
buttons, drop
down buttons, 

and combo 
boxes on 
too/bars. 

Drop-down button (closed) 

Drop-down 
button (opened) 

'\!m NewT able 
'@ NewQueiY 
,.~ NewForm 

'ill New Report 
J£:2 New Macro 

-:~ New Module 

Square 
(normal) 
button 

Combo box 

Drop-down button with 
portable palette (opened) 

• 

3. Do one of the following, depending on the type of button you're pointing to (see 
Figure 1.5 for examples): 

• For a square (normal) button, click on the button. 
• For a drop-down button, you have two choices. Either click on the picture part of 

the button to take whatever action the picture shows, or click on the drop-down 
arrow next to the picture and then choose an option from the menu or palette 
that appears. 

• For a combo box, click on the drop-down arrow next to the box and then 
choose an option from the list that appears, or click on the drop-down arrow 
and then type your choice into the text box. 

If you change your mind about choosing a drop-down button or combo box after 
you've clicked on its drop-down arrow, click on the drop-down arrow again or 
click on an empty area outside the toolbar. 

If the drop-down button opened a palette, you can drag the palette anywhere on 
the screen. After you detach the palette from its button, the palette remains open 
and avai lable until you click on lhe Close button on the palette, click on the arrow 
next to the drop-down button, or close the object you're working with . 
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Viewing Toolbars, ScreenTips, and the Status Bar 

MiMU;IIM 
This sample 

Startup dialog 
box shows 

default options 
that work 

well for most 
people. Choose 

Tools >- Startup 
to get here. 

Toolbars, ScreenTips, the status bar, and other on-screen features are optional and cus
tomizable. If you don't see one of these features in Access, chances are it's just hidden 

(or turned off). 
To display (or hide) the status bar or the startup dialog box (refer to Figure 1.1): 

1. Open any database window. (The Tools>- Options and Tools>- Startup commands 
described below are available only when a database is open.) 

2. Choose Tools>- Options from the Access menu bar and then click on the View tab. 
3. Select (check) an option to display (or turn on) the feature; deselect (clear) the 

option to hide (or turn off) the feature. For example, select Status Bar and Startup 
Dialog Box to display the status bar and startup dialog box described in Chapter 4. 

Click on OK. 

To display or hide Screen Tips (the descriptions that appear when you point to a tool
bar button): 

1. Choose View >- Toolbars >- Customize from the Access menu bar and then click on 
the Options tab. 

2. Select (check) Show ScreenTips on Toolbars to show a brief description of what a 
toolbar button does when you point to it. 

3. Click on Close. 

You also can customize many startup features for the current database (including 
whether the database window, status bar, and built-in toolbars appear). To do so, choose 
Tools>- Startup. You'll see the Startup dialog box shown in Figure 1.6. As usual, you can 
select (check) options you want to turn on and deselect (clear) options you want to turn 
off. You also can type text into the text boxes and choose options from the drop-down 
lists . When you're finished making changes, click on OK. See Chapter 15 for more about 
personalizing Access. 

ARPficalion Title: 
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Pressing the Shift key when you open the database will bypass any Startup 
options that you've changed, giving you the default options shown in Figure 1.6. 

Positioning the Toolbar or Menu Bar 
By default, the toolbar is docked just below the menu bar (refer to Figure 1.4). You can 
convert the tool bar to a free-floating element or dock it to some other edge of the screen. 
You can also move the menu bar or dock it in a new location. Follow these steps to move 
the menu bar or a toobar: 

1. Move the mouse pointer to some blank area between buttons (or below or above a 
button) on the toolbar. 

2. Drag the menu bar or toolbar toward the center of the screen, double-click to make 
it free floating (see the example below), or drag it to some other edge of the screen 
to dock it there. To restore a floating menu bar or toolbar to its previous docked 
position, double-click on its title bar or any empty spot on it. 

D ~!i! I ~C9.~ 
"'1\1 ifl] • l1) 

When the toolbar is floating freely, you can drag it by its title bar (or by any empty 
space between buttons) to any place on the screen. Here are some other toolbar tips: 

• To close (hide) the floating toolbar, click on the Close button on the toolbar's 
upper-right corner or right-click on any toolbar and click on the toolbar's name in 
the shortcut menu that appears (shortcut menus are discussed in the next section). 

• To redisplay a hidden toolbar, choose View > Toolbars, click on the checkbox 
next to the toolbar you wish to view, and then click on the Close button in the 
Toolbars dialog box. 

• To redisplay a default toolbar for the current view, right-click on any visible 
toolbar and then click on the toolbar's name in the shortcut menu that appears. 

If the redisplay procedures above don't work, choose Tools> Startup, select (check) 
Allow Built-In Toolbars, and then click on OK. Close and then open the database again. 
If necessary, choose View > Toolbars to redisplay the toolbar. 

We discuss many other ways to use and customize the toolbars in Chapter 23. But for 
now, just knowing how to hide, display, and position the tool bar is enough. If you do need 
a quick reminder or more information on toolbars, search the Help index for Tuolbars. 
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If you manually show a built-in toolbar, it will appear in every view. If you hide a 
built-in tool bar from within its default view, it will be hidden in every view (includ
ing its default view). 

Opening Shortcut Menus 
Access provides many shortcut menus to save you the trouble of looking for options on 
the menu bars and tool bars. Shortcut menus in the Open and Save dialog boxes also 
offer handy ways to manage your files and folders without leaving Access. 

To open a shortcut menu that's tailored to whatever you want to work with, right
click on the object or place you're interested in; or click on the object and then press 
Shift+FlO. For example, right-clicking on a table name in the database window opens 

this menu: 

Suppliers 1 s-. &5/Export ... 

If the shortcut menus don't appear when you right-click, choose Tools ~ Startup, 
select (check) Allow Default Shortcut Menus, and choose OK. Then close and 
open the database again. 

0 
~ 
-~ 
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> 
0 
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To select an option from the menu, do one of the following: 

• Press Enter if you want to choose the boldfaced option on the menu. 
• Click on the option with either the left (primary) or right (secondary) mouse button. 
• Type the option's underlined letter or highlight the option with your mouse, and 

then press Enter. 

To close the menu without selecting an option, press Esc or Alt or Shift+FlO-or 
click outside the menu. 

The term right-click means to point at something with your mouse and then click the 
right (secondary) mouse button. This right-click trick is available throughout Access 
(and, indeed, throughout Windows). As you work with Windows and Access, be 
sure to experiment with right-clicking. It is a great way to discover some truly use
ful shortcuts. 

Closing a Database 
When you're done working with a database, you should close it. Any of these methods 
will work: 

• Click on the Close button in the upper-right corner of the database window. 
• Go to the database window and then choose File > Close from the Access menu bar. 
• Press Ctrl+W or Ctrl+F4. 

As usual, you'll be prompted to save any unsaved work. 

You can have only one database open at a time. Access will automatically close 
~=-~ the currently open database if you choose File >- Open Database or File >- New 

Database before closing the current database. 

Getting Help 
One thing we hope to teach you in this book is how to get answers to questions-even if 
we haven't provided those answers. You can achieve this goal easily if you learn how to 
use Access's plentiful built-in Help. We'll show you how to use this self-help tool next. 
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Summary of Self-Help Techniques 

I 

Table 1.2 summarizes many ways to get and use online Help in Access . Remember that 
you can use all the standard Windows techniques while you're in the Help system to 
annotate Help, print a topic, change fonts, and so forth. For more information on those 
topics, see your Windows documentation or the Windows online Help. You can exper

iment by right-clicking in any Help text window and choosing options from the 

shortcut menu. 

TABLE 1.2: MICROSOFT ACCESS 97 ONLINE HELP OPTIONS AND TECHNIQUES 

TYPE OF HElP 

Office Assistant 

Table of Contents 

Search Help 

Find Help on the Web 

Display a Minimized 
Help Window 

What's This ... ? 

Version Number, 
System Information, 
Technical Support 

Exit Help 

HOW TO GET IT 

Choose Help ~ Microsoft Access Help or click the 
Office Assistant button on the Toolbar. 

Choose Help ~ Contents and Index and click on the 
Contents tab in the Help Topics dialog box. 

Click on the Index or Find tab in the Help Topics 
dialog box. 

Choose Help ~ Microsoft on the Web and make a 
choice from the next menu. Use Web Tutorial to find 
out more about these options. 

Click on the ? Microsoft Access button on the 
Windows 95 Taskbar. 

Choose Help~ What's This?, press Shift+Fl, click on 
the ? button on the toolbar or at the upper-right 
corner of a dialog box; then click on the command or 
place you want help with. 

Choose Help ~ About Microsoft Access. 

Click on the Close button at the upper-right corner of a 
Help screen or press Esc. 
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To select an option from the menu, do one of the following: 

• Press Enter if you want to choose the boldfaced option on the menu. 
• Click on the option with either the left (primary) or right (secondary) mouse button. 
• Type the option's underlined letter or highlight the option with your mouse, and 

then press Enter. 

To close the menu without selecting an option, press Esc or Alt or Shift+ FlO-or 
click outside the menu. 

The term right-click means to point at something with your mouse and then click the 
right (secondary) mouse button. This right-click trick is available throughout Access 
(and, indeed, throughout Windows). As you work with Windows and Access, be 
sure to experiment with right-clicking. It is a great way to discover some truly use
ful shortcuts. 

Closing a Database 
When you're done working with a database, you should close it. Any of these methods 
will work: 

• Click on the Close button in the upper-right corner of the database window. 
• Go to the database window and then choose File ~ Close from the Access menu bar. 
• Press Ctrl+W or Ctrl+F4. 

As usual, you'll be prompted to save any unsaved work. 

You can have only one database open at a time. Access will automatically close 
»--~ the currently open database if you choose File >- Open Database or File >- New 

Database before closing the current database. 

Getting Help 
One thing we hope to teach you in this book is how to get answers to questions-even if 
we haven't provided those answers. You can achieve this goal easily if you learn how to 
use Access's plentiful built-in Help. We'll show you how to use this self-help tool next. 
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Summary of Self-Help Techniques 

I 

Table 1.2 summarizes many ways to get and use online Help in Access. Remember that 
you can use all the standard Windows techniques while you're in the Help system to 
annotate Help, print a topic, change fonts, and so forth. For more information on those 
topics, see your Windows documentation or the Windows online Help. You can exper
iment by right-clicking in any Help text window and choosing options from the 

shortcut menu. 

TABLE 1.2: MICROSOFT ACCESS 97 ONLINE HELP OPTIONS AND TECHNIQUES 

TYPE OF HELP 

Office Assistant 

Table of Contents 

Search Help 

Find Help on the Web 

Display a Minimized 
Help Window 

What's This ... ? 

Version Number, 
System Information, 
Technical Support 

Exit Help 

HOW TO GET IT 

Choose Help ~ Microsoft Access Help or click the 
Office Assistant button on the Toolbar. 

Choose Help ~ Contents and Index and click on the 
Contents tab in the Help Topics dialog box. 

Click on the Index or Find tab in the Help Topics 
dialog box. 

Choose Help ~ Microsoft on the Web and make a 
choice from the next menu. Use Web Tutorial to find 
out more about these options. 

Click on the ? Microsoft Access button on the 
Windows 95 Taskbar. 

Choose Help ~What's This?, press Shift+Fl, click on 
the ? button on the toolbar or at the upper-right 
corner of a dialog box; then click on the command or 
place you want help with. 

Choose Help ~ About Microsoft Access. 

Click on the Close button at the upper-right corner of a 
Help screen or press Esc. 
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Using the Help System and This Book 
This book is designed to complement the Help system, not to replace it. Because the 
online documentation does such a good job of showing you the steps for practically 
any procedure you can perform in Access, and because many of those procedures won't 
interest everyone, we've taken a more conceptual approach here-one that should help 
you work more creatively. Instead of presenting hundreds of little step-by-step instruc
tions (as the Help system does), this book deals with larger, more general concepts so 
that you can see how (as well as when, why, and sometimes whether) to apply the 
nitty-gritty details you'll find in the Help system. 

From time to time, this book shows an information symbol like the one at left (in 
fact, you've already seen a few in this chapter). This symbol is a reminder that, once 
you've learned the underlying concepts and the basic techniques involved in a topic, 
you can find further details under the Help topics identified next to the symbol. 

Looking Up Information 
Like a book, the Access Help system has a table of contents, which is a great way to learn 
how to do things. To get to the Help contents: 

• Choose Help,.. Contents and Index from the Access menu bar and then click on 
the Contents tab in the Help Topics dialog box. 

Or if you're already in a Help window 

• Click on the Help Topics button near the top of the window to return to the Con
tents, Index, or Find tab you selected most recently. 

The Contents lists many options to explore. Figure 1. 7 shows the Contents tab with 
the Getting Help book opened. To open or close a book, double-click on the book's icon. 
To open a topic (preceded by a question mark icon, like this ?), double-click on that 
topic. In Figure 1.8, you see the Help window that opened after we double-clicked on 
the Getting Help book and then double-clicked on the Sample databases and applications 
included with Microsoft Access topic. 

Here are some tips for using a Help window (see Figure 1.8): 

• To view Help text that's hidden at the moment, use the vertical and horizontal 
scroll bars as needed or resize the Help window. 

• To jump to a related topic, click on the small button next to that topic in the 
help text. The mouse pointer changes to a pointing hand when you point to a 
jump button. 
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• lrlijrliiM 
Help T opocs lolocoosolt Access 97 I] £1 

Contents jtndex I Find 

Click a topic, and then click Di$pl8)1. Do click another tab. such as Index. 

The Contents 
displays elec
tranic books 

filled with help 
on many topics. 
Double-click on Double-click to open a closed book. What's New 

books to open or 
close them. Double-click to close an open book. 

Double-click on 
topics to 

op~n them. 

M#d@II:M 
A Help window 
that describes 

the sample 
databases and 

applications 
that come 

with Access. 

Gelling online Help on Visual Basic for applications 

Copy Visual Basic for applications examples in online Help 

Glossaty 

Mictosofl Access accessibility 
Use shorlcul keys 

Double-click on a topic to view it. Sample d,tabase> and appllcaiLOI\1 rncluded wrlh Mrcro~r~l Acoe 

• Office Assistant 

~ Converting a Previous-Version Database to Microsoft Access 97 

• Creating a Database and Working in lhe Database Window 
• Creating, I mporling, and Linking T abies 

~·~-W-o-rk-in_g_w_il_h_D_a_I•--------------------~~--J~ 

frn ... 

Click here to return to the Help Topics. 
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I 
Sample databases and applications Included with ~ Microsoft Access 

Microsoft Access provides a sample database and two sample appli cations 
that you can use while you're learning Microsoft Access: 

~~ I 
. Norlhwind Traders sample database. Use this sample database when 

you're first learning Microsoft Access The Northwind database contains 
the sales data for a fictitious company called Northwind Traders, which 
imports and exports specialty foods from around the world . By viewing 
the tables , queries, forms, reports, macros, and modules included in the ';)I 

Northwind database, you can develop ideas for your own Microsoft 
Access database. You can also use the Northwind data to experiment 
with Microsoft Access before you enter your own data. For example, you 
may want to practice designing queries using the Orders table since II 
contains enough records to produce meaningful results 

The Nottllwind database includes a Help file called snow Me that shows 
the main features in the database 

.. 

. Orders sample application. The Orders sample application is an 
instructional aid for _fj_4l:~o.:;!!~·J A.nw):(fJ}/~>;~.~·?.·~~:l}JJ.J~:1i•,:!Q:~9!1 Aq~t?:~·~-~!1.. Use 

6 this application with BuildingApp/ica/ionslo learn how to create a simple 

' 
application 

• 

• 
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• To see the definition of a term or a button, click on any text that's underlined 
with dots (usually in green) or click on a picture of a button. (Click anywhere 

inside or outside the definition or press Esc to hide the definition again.) 
• To print the current Help window, click on the Help window's Option button 

or right-click anywhere in the Help window text; then choose Print Topic. 
• To return to the previous Help window, click on the Help window's Back button. 

• To return to the Help Topics (refer to Figure 1. 7) from any Help window, click 
on the Help window's Help Topics button . 

• To make the Help window reappear if it's minimized or hidden, click on the 
Microsoft Access For Windows 95 Help button on the Windows Taskbar (the but
ton name is preceded by a small? icon). 

• To close the Access Help window, make sure it's the active window and then 

press Esc or click on its Close button. 

Help with Whatever You're Doing 

MitijQ;liiW 
Hint boxes and 

the status bar 
often provide 

further informa
tion about what 

to do next. 

Even when you're not in a Help window, you should look at the status bar, preview 
areas, and any colored text on the screen for hints on what to do next. For example, 
you'll often see a hint box on the object and a description of available shortcut keys in 

the status bar, as shown in figure 1.9 (though that example won't appear until you 
design a table, as discussed in Chapter 6). 

llei'J!3faf I Look~ I 
Field Size Long lnlege• 
New Values Increment 
F01mol 
C•plion 
Indexed 

Calegm~ ID 
Yes (No Duplicales) 

Status bar information 

A lield name can be up lo 64 
characters long, it1cluding spaces 

P1ess F1 f01 help on field names 

Hint box 

• 
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Searching Help 

.ddU;llll•l 
The Index tab 
after we typed 

closing in the 
text box. 

Like any good book, the Help system also has its own index. You can search the index 
for help with just about any topic. Here's how: 

1. Go to the Help Topics window as explained earlier in this chapter and then click on 
the Index tab (or the Find tab). Figure 1.10 shows the Index tab's contents after we 
typed closing in the text box. 

2. Type a word or select one from the list of topics . Search is not case sensitive. This 
step highlights the closest match to your entry in the list(s) below the text box. 

3. Click on Display (or double-click on a topic). 

Once a Help window opens, you can use any of the techniques described earlier to 
work with that window (see "Looking Up Information"). 

Help T opocs Mocmsoft Access 97 fJ 1E3 

Contents Indo!< I Fird I 

1 ll'P" lhe fwst few letteos ollhe wood you'oe lookirog foo. 

~IDMd 

2 .t;lick I he irde• entoy you wllllt and I hen cick Dis play. 

Cl01eCuuentDatab...., malh . . . 
cln~ng r.lalal;l...-e object' 
closing DDE channels 
closing Iiies 
closing toolbars 
closing windows 
Code Buildeo 
code 

actions reference 
active object or database when running code 
arguments 
calling macros 
calling procedlues 
compatibility with previous versions of Microsofl Access 
compiling 
conhol flow ' " 

Qisplay :_ ;,• Cancel 

• 

Asking the Office Assistant 
The Office Assistant enables you to search for information by typing in a few words. The 
more specific your words are, the more specific the suggested topics will be. But you don't 
have to worry about matching a topic name exactly because the Office Assistant is pretty 
forgiving and even quite smart. 
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To use the Office Assistant, choo~e Help>- Microsoft Access Help frotn the Access lllt' llll 

bar, press F I, or click on the Office Assistant button on the toolb<Jr (see Figure I. I I). The 

ilssistant <~ppcars <IS <Jn animated paper clip, but you can choose from seve ral other 

graphics. Just click the Options button in thl'' Yl'llow Lmh!Jie for the ilSSistzmt <llld click 

on the (;allery tab. Besides choosing the appearance of tile assistant, you Gill change its 

behavior. Click on the Options tab in the Office Assistant dialog box, make your selec

tions, and click on OK. 

To get help from the Office Assistant, first open tile assistant if it 's not already visible 011 

the desktop. If you don't see a yellow bubble with a Search button, click anywhere 

on the assistant, then type a few words describing what you want to do in t·he box 

under Whut would you like to do?, and prl'Ss Entl·r or click on the Search button. Wh en 

the list of related topics appears, click on the topic you're interes ted in to open the cor

responding Help e ntry. 

In Pigure l.l ·1, we typed customizing toolbars ancl pressed Enter. The Office /\ssis

tanl' ignores extraneous words, such as flow c/o f fix, and focuses on the important 

keywords, such as too/bar ancl Cll.\to111izing. It then displays a list of topics that' seem to 

answer your question. 

•~t•i~t~a~'"I.~·l~jlr.lfrlrll .. ----------------------------------------------------------------------------il 
The Office Assis

tant showing 
Help topics on 

customizing 
too/bars. 

D Employee; 

[~ Order' Det.:J il::; 

[] (lr'der'c. 

ImJ PrfJcluds 

lilll Sl11pperc 

[ill Suppliers 

=c:-:7-.,.-,-:""l 
What would you like to do? 

l» Restore original bul~tons and menu:; on .3 

burlt-irr toolbar or menu bar 

0 Chan~~e the irna~~e on a tocdbar butb:1n or 
menu command 
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Asking "What Is This Thing?" 
Another way to get quick information is to use "What's This?" Help. This type of help 
explains the function of menu command, button, or dialog box option. 

1. Press Shift+Fl or click on the Help toolbar button (shown at left). If you're in a dia
log box, click on the ? button in the upper-right corner of the dialog box. The 
mouse pointer changes to a combination arrow and question mark. 

2. Click on a button on the toolbar or select commands from the menus or click on 
a place in the dialog box to get help with that particular item. 

If you change your mind about using What's This? Help before choosing a topic, 
press Esc or Shift+Fl, or click on the Help or? button again, to return to the normal 

mouse pointer. 
Here are some other ways to get What's This? Help: 

• In a dialog box, right-click on the option name or button you're curious about 
and choose What's This? 

• In a dialog box, click on or tab to the place you want help with and then press 
Shift+Fl or Fl. 

• In the menus highlight the option you want help with and then press Shift+Fl or Fl. 

Version Number, System Information, 
Technical Support 

Do you need to check the version of Access you're using to see how much memory and 
disk space are available or to find out how to get technical support? It's easy: 

1. Choose Help ~ About Microsoft Access to open the About Microsoft dialog box. 
2. Click on the System Info button (for information about your system resources) or 

click on Tech Support (for details about getting help from humans). 
3. Click on the Close and OK buttons (or press Esc) as needed to return to Access. 

Getting Out of Help 
You can get out of Help in many ways, but the easiest is simply to make sure the Help 
window is active (click on the window or its Taskbar button if you need to) and then 
press Esc as needed. 
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In addition to the online Help described in this chapter, Microsoft offers many 
other sources of help for Microsoft Access, Microsoft Office, and other Microsoft 
products. See Chapter 4 for information about these additional resources. 

Exiting Microsoft Access 97 
When you're done using Access, you should return to Windows before shutting down 
and turning off your computer. You can exit from Microsoft Access using the technique 
you'd use with other Windows programs: 

1. Go to the database window or to the main Microsoft Access window. 
2. Choose File >- Exit or click on the Close button in the upper-right corner of the 

Microsoft Access window or press Alt+F4. 

To exit Access when Access is minimized, right-click on the Microsoft Access but
ton on the Windows Taskbar and then choose Close. 

You'll be returned to Windows or to another open program window. If you want to 
shut down and turn off your computer now, exit any open programs normally and 
choose Start >- Shut Down from the Windows Taskbar. Next choose Shut Down The 
Computer?>- Yes and wait until Windows tells you it's safe to turn off the computer. 

Where to Go from Here 
Where you go from here depends on your past database experience. 

• If you're new to Access and to databases, continue with Chapters 2 and 3. 
• If you're new to Access but know something about databases, try the hands-on 

guided tour in Chapter 3. 
• If you're familiar with Access, flip to the "What's New in the Access Zoo" section 

at the end of most chapters in this book, including this chapter. For another view of 
what's new, go the Help Topics dialog box (Help>- Contents and Index), click on 
the Contents tab, double-click on the What's New book, and then double-click on a 
What's New topic. 



What's New in the 
Access Zoo? 
Many features discussed in this chapter 
are new to Access 97, which include 

• Menu commands that have equiva
lent toolbar buttons now include 
icons to help you learn toolbar short
cuts. Menu commands also appear as 
buttons when you point to them. 
Toolbars and menus are now com
bined into command bars with 
drop-down menus and buttons. The 
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command bars share icons with other 
Office applications. You can position 
toolbars and the menu bar to float 
anywhere on the desktop or docked 
on any side. 

• The Office Assistant is a new ani
mated Help tool that offers sugges
tions for completing database tasks. 
You can choose from a variety of 
assistants including an Einstein-like 
genius, a spinning Office logo, and 
"Mother Nature." 
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